
Support and Services

If you are experiencing problems or getting unexpected results using HiJaak PRO, the Troubleshooting, 
Tips and Tricks help might help you find a solution. To get help, click on the following:

Troubleshooting HiJaak PRO

If you encounter problems you are unable to solve through the use of online Help, printed manual, or the 
Troubleshooting Help file, you can call our Technical Support department. Registered users of HiJaak 
PRO and other Quarterdeck products are entitled to 3 months of free technical support, starting with your 
first request.

For more information on techncial support, click on the following:

Technical Support



Technical Support

Registered users of HiJaak PRO and other Quarterdeck products are entitled to 3 months of free 
technical support, starting with your first request.

You can get technical support by CompuServe, electronic support forums, fax, mail or telephone. See 
below for numbers, addresses and availability.

 CompuServe: GO QUARTERDECK
 Internet: support@qdeck.com 
 FTP site qdeck.com 

Host Name: qdeck.com (149.17.8.10)
Login: Anonymous
Password: your e-mail address
Notes: obtain the README file from the ~/pub directory

 World Wide Web site: http://www.qdeck.com/
 Automated support: 1-800-ROBOTECH (1-800-762-6832) 
 BBS: 310-309-3BBS (8 bit word length, no parity, 1 stop bit)
 FAX: 310-309-3217 
 Mail:

Quarterdeck Corporation
Technical Support Team
13160 Mindanao Way, Fl. 3
Marina del Rey, CA 90292-9959 USA

 Phone: 310-309-4250 (have your Quarterdeck VIP and product serial numbers available)



Troubleshooting, Tips and Tricks for Using HiJaak PRO

If you are having problems using HiJaak PRO, or if you are getting unexpected results, you can find 
possible solutions in this help file. 

Tip: If you are having problems working with a file in HiJaak PRO and none of the 
troubleshooting tips and tricks work, try converting the file to another format and trying 
again.

Click on the feature of HiJaak PRO with which you need troubleshooting help:

 Basic Look of an Image
 Capture
 Catalogs and Updates
 Clipboard Support
 Colors
 Conversions and Formats
 Error Messages
 Find
 HiJaak PRO and Windows 95 Applications
 Installing and Setting Up HiJaak PRO
 Macintosh Files
 Printing
 Scaling and Resizing
 Scanning (HiJaak Scan)
 System Problems
 Text and Fonts
 Viewing





Clipboard Support

Q. Why do I get an "Error -1017: Source Corrupt or Unsupported" when I try to paste an image into
an application after I have copied it to the clipboard using the Copy As command? 

A. Although HiJaak PRO allows you to select the format in which you want to copy your image to the 
Clipboard, the format you select must be compatible with the image’s original format. For example, if 
you choose to copy a PCX file to the Windows Clipboard in TXT format, you will get this error because 
PCX files do not contain TXT information. If you want to copy a raster image to the Clipboard, select a 
raster format. If you want to copy a vector image to the Clipboard, select a vector format. Only select 
TXT if your image is in TXT format. If you do not know which format to select, leave the Select 
Clipboard Format dialog box alone. HiJaak PRO will provide the image to the pasting application in 
whatever format the application requests.

Q. When I try to paste a vector image into HiJaak PRO, the results are very poor or the image 
won't paste at all. What can I do to fix this problem?

A. By default, HiJaak PRO pastes vector images in EMF format. If this is not working well, you can try 
pasting in WMF forrmat. Click here  to change the default in the Registration database. If you want 
to change the default back to EMF, click here    

.



Colors

HiJaak PRO Problems With the Colors in an Image
If the colors in your image do not look right, click on the problem below that most closely matches your 
situation:

 The image has strange patterns throughout
 The image is too light or too dark
 The image looks like a photo negative
 Invert colors doesn't seem to be working right
 My black and white print-outs of color images look bad
 My color changes don't appear correctly or colors seem to be changing for no reason
 My grayscaled image looks bad
 Palette Optimization seems to have no effect
 Reverse Black and White seems to have no effect
 When I reduce colors, the image looks bad



The image has strange patterns throughout

Q. Why is there a box-like pattern in my image?
A. Using Dither in HiJaak PRO not only "blends" colors from the Windows palette to approximate the 

colors of your original image, but it blends them in a distinct pattern.    If this box-like pattern is very 
obvious, you may want to use Diffuse, which blends colors from the Windows palette in a more 
random pattern. Note that Diffuse takes longer to process.

Q. Why is HiJaak PRO's default Reduction Method set to Dither?
A. HiJaak PRO uses Dither because it's the quickest way to get the best display of images that contain 

more colors than are available in your Windows palette. Snap is faster than Dither, but the results 
aren't as good.

Q. Why are there "worming" patterns in my image?
A. When using the Diffuse option, this is always a potential problem. Use the Dither option and see if you

get better results. Colors in your image that are not available in your Windows palette must be 
approximated using either Dither or Diffuse patterns. Choose the one which gives you the best 
results.



The image looks too light or too dark

Q. How do I convert a captured screen with a dark-colored background to grayscale and get an 
image that is not too dark?

A. Set Brightness up to +15 or +20 to lighten the image overall.    If only the foreground is too dark, use 
Contrast at about +15 or +20 to lighten the foreground.

Q. How can I lighten the middle-range of colors, while leaving extremely light and extremely dark 
areas alone?

A. To lighten mid-range areas, increase the Gamma Correction. Pull down the Colors menu and select 
Contrast and Brightness (Alt+c, b).    In the Contrast and Brightness dialog box, increase the 
Gamma Correction until the thumbnail looks as you want your image to look (Alt+G). Click on OK.

Q. My image appears to be all approximately the same muddy color.    How can I see the 
differences in the colors more clearly?

A. When the tones represented in your image appear to be basically the same color or colors throughout 
the image, use Histogram Equalization to perform an analysis of the tones and separate them evenly
to produce a clearer-looking image. Pull down the Colors menu and select Contrast and Brightness 
(Alt+c, b).    In the Contrast and Brightness dialog box click on the      Histogram Equalization check 
box (q). Note that this option will have little effect on images in which the tones are already spaced 
evenly.

Q. Why does the color white sometimes appear as a light pattern in my printouts?
A. If you are viewing a 24-bit image, what shows up on your monitor as white may, in fact, be slightly off-

white or a light gray. Because it usually has just black ink or black toner to represent shades, your 
printer must show the light gray as a halftone pattern. The halftone patterns generated on high 
resolution output devices, such as image-setters, will produce good-looking, highly accurate results. 
On lesser resolution devices, it may be necessary to experiment with different brightness setting to 
produce the best printed results.



The image looks like a photo negative 

Q. Why does my displayed image appear as a photographic negative?
A. In certain situations, the color palette is inverted producing the effect of a photographic negative.    Pull 

down the Colors menu and select Invert Colors to restore the proper colors (Alt+c, i).



Invert Colors doesn't seem to be working right

Q. Why is the Invert option switching black and white to other colors instead of reversing them?
A. Invert is used not to reverse black and white, but to invert the entire color palette. Often what may 

appear as black or white on your monitor is actually a dithered pattern of other colors. If you use invert 
on these dithered patterns, each individual color will invert; therefore what appeared as black will not 
appear as white and vice versa. 
Note that if you don't want to invert the entire color palette, but you do need to interchange black with 
white, pull down the Colors menu and select Reverse Black and White (Alt+c, r).

Q. Why does part of my image disappear after I select Invert Colors?
A. If parts of the image are the same color as the background after inversion, this will happen. For 

example, if you invert an image containing black objects on a white background, the black objects will 
become white and will be hidden on the white background. To workaround this problem if the 
background color is white, as in this example, you could try using HiJaak PRO’s Colors\Reverse 
Black and White option to change the white objects back to black. If not, change the background 
color HiJaak PRO uses by pulling down the Setup menu, select Preferences and setting a different 
Background Color. 



My black and white print-outs of color images look bad 

Q. How do I achieve the clearest possible black and white printout of a color line-drawn vector 
image?

A. Pull down the Colors menu and select All Colors to Black (Alt+c, c); every non-white object in a 
vector image will become black.    A printout will show solid black objects and lines.

Q. How do I get a clear black and white printout of my raster image?
A. If you are printing to a dot matrix or LaserJet printer, in the Print Options dialog box select the 

Grayscale option and click on the Reduce Colors button.    In the Reduce/Expand Colors dialog 
box, select Number of Colors=2, and a Reduction Method of Snap. HiJaak PRO will look at the 
colors in the file and determine whether they are closer to white or black and snap each color to either 
black or white.    For instance, yellow is closer to white and will become white.    Blue is closer to black 
and will become black.    If you were to use All Colors to Black instead of the options listed above, 
you will most likely get an all black image.    

A. If you are printing to a PostScript language printer, select the Grayscale option, but leave the Number 
of Colors the same using the Snap Reduction Method.

Q. Why does the color white sometimes appear as a light pattern in my printouts?
A. If you are viewing a 24-bit image, what shows up on your monitor as white may, in fact, be slightly off-

white or a light gray. Because it usually has just black ink or black toner to represent shades, your 
printer must show the light gray as a halftone pattern. The halftone patterns generated on high 
resolution output devices, such as image setters, will produce good-looking, highly accurate results. 
On lesser resolution devices, it may be necessary to experiment with different brightness setting to 
produce the best printed results.



 My color changes don't appear correctly, or colors seem to be changing for no 
reason

Q. Why isn’t List Color Changes\Modify working? I made changed a color and now I want to 
modify it, but HiJaak PRO won’t change anything when I select modify.

A.. List Color Changes is working: Once you have applied the first color change, like yellow-blue, there is 
no yellow left. If you don't reload the original image the yellow to anything you modify it to will have no 
effect since there is no longer any yellow in the current image. If you re-open the original image, 
modify the color change and click OK (apply should already be checked), it should work. 

Q. Why does changing a color in my 24-bit raster image change other similar colors too?
A. This is a feature of the Change a Color option which will change the color you select, as well as 

change similar colors within a certain tolerance.    Because 24-bit images commonly have gradient fills 
that are nearly undetectable, this allows you to change the whole area with only one color change.

Q. Why does HiJaak PRO appear to be changing the colors of some objects in my DXF file?
A. DXF images will open with Reveal Background Color Objects selected as default, mimicking the 

behavior of AutoCAD.    If there are objects the same color as your chosen background, HiJaak PRO 
will automatically change those objects to a contrasting color so they are visible.

Q. Why do I get unexpected results when I change colors in my DXF file?
A. Because HiJaak PRO mimics AutoCAD's default of Reveal Background Color Objects, when objects

would otherwise blend into the background color, it will sometimes respond unexpectedly to a color 
change that is to be performed on an already changed object or line.    Though an object may appear 
to be one color on-screen when performing a color change, the HiJaak PRO color selector is reporting 
the true object color as indicated in the image file.

Q. Why aren't the colors in my 256 color image viewing properly?
A. If you are using a standard Super VGA graphics card and you are not running Windows in a 256 color 

mode, you will not be able to view an image with 256 colors properly.    Windows cannot supply 
enough colors from its palette for HiJaak PRO to view it properly.

          Either select a graphics mode from the Control Panel's Display\Settings that supports 256 colors (if 
your graphics card supports it), or display the image using the Reduction Method of Dither or 
Diffuse in HiJaak PRO.    Reduction methods will not display exact colors, but will blend the colors 
available in the Windows palette to produce a more attractive image.

Q. Why does a colored background appear when I rotate an image after using the Optimize Palette
option?

A. When an image is rotated a number of degrees that is not an even multiple of 90, the resulting image 
will no longer fit into the rectangular window available for it. HiJaak PRO must pad the image with 
pixels of a certain color to fill out the rectangular window. Whenever possible, HiJaak PRO will fill out 
the image with the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, eliminate the 
background color from those available for the particular image. Another background color -- one that is
available in the new optimized palette -- is selected to fill out the image window. To ensure that no 
color substitution takes place, rotate the image before selecting optimize palette. Performing the 
rotation first will introduce the background color into the image and it will be preserved as part of the 
palette through the optimization process.

Q. I've used Change a Color to change color A to color B but then decided to reverse the process 
by using Change a Color to set color B back to Color A. Now whenever I perform any 
processing on my image I see it repaint first in color A then Color B and then Color A again. 
How can I halt this process?



A. Color changes in HiJaak PRO do build one upon another. To eliminate the repaints, you must also 
eliminate the color changes that are causing the repaints. Do this by selecting List Color Changes 
from the Colors menu and selecting the Clear button.

Q. Why can't I change colors in my vector images?
A. Color changes in vector image are unpredictable if you are displaying less than 32,000 colors in 

Windows 95. The unpredicability is due to HiJaak PRO's need to create colors using a dithered 
pattern. Try using a display mode with a higher number of colors. You can change the display mode 
using the Control Panel's Display control.



Palette Optimization seems to have no effect

Q. Why doesn't Palette Optimization improve the output image?
A. Palette Optimization only has an effect if you reduce the number of colors in the output image.



Reverse Black and White seems to have no effect

Q. I selected Reverse Black and White and it did not have any effect on my image.
A. Often colors that appear to be black or white are actually not true black and true white.    Reverse 

Black and White only reverses true black and true white.    If this option seems to have no effect on 
your image, you probably don't have any black or white in the image. The colors that appear as black 
and white probably do because your image has more colors than can be displayed; therefore, very 
dark colors will be represented on the display as black, and very light colors will be represented in the 
display as white.



When I reduce the Number of Colors, the image looks bad 

Q. How do I reduce the number of colors and still get an attractive image?
A. If you wish to reduce a 16 million color image to 256 colors, you should use HiJaak PRO's different 

palette options to get the best results. Use the Reduction Method of Dither or Diffuse, and select the
Optimize Palette option from your Reduce/Expand Colors dialog box for best results.



My grayscaled images look bad

Q. Is one format better to use for grayscaling?
A. The TIFF format supports entirely grayscale palettes, and so is better when converting to grayscale 

images. Other formats such as PCX must use combinations of black and white to approximate grays.

Q. Why do I occasionally see strange colors appearing in my image when I make it grayscale?
A. The presence of non-gray colors in a grayscale image will occur most often when dealing with 16-color

images or running Windows in a 16-color graphics mode. There may be no grays or few grays in the 
palette available to HiJaak PRO in those circumstances. HiJaak PRO is forced to substitute another 
available color for the unavailable gray or grays.



Conversions and Formats

For help with conversions and file formats in general, click on the format below with which you need help:

 3DS
 CGM
 DXF
 EMF
 GEM
 ICO
 JPG
 PCL
 RLE
 TXT
 WMF

If none of the above topics apply, click on the following:
General conversion problems



3DS

Q. I converted an IGS file to 3DS and now some of the objects are missing. What should I do?
A. To see the lines and text in a 3DS file, select View\3D Rendering\Wireframe. Not all objects appear in 

Flat or Gouraud rendering modes.

Q. Why does part of my image turn black when I move it from off the edge of the screen?
A. This is a known problem that occurs rarely for some users, such as those using the Matrix MGA 

Millenium graphics card, when an image opens cascaded and partially off the screen. If you see this 
problem, close all open images and try opening the problem image again.



RLE

Q. Why do the file sizes of some RLE files increase when I convert from BMP to this file type?
A. The RLE compression type is effective only when a BMP image has a large number of similarly colored

dots (or pixels) in close proximity to each other. Other types of BMP files may not be compressed at all
when the RLE is selected, and some may actually increase in size.



CDR

Q. Why doesn't HiJaak work with my CDR5 files?
A. HiJaak PRO supports CDR 5 files only if they have an embedded CMX file. To ensure that your CDR 

files contain an embedded CMX file, select the Save Presentation Exchange Data check box in the 
CorelDRAW Save As dialog box.



CGM

Q. Why does my CGM image open with a background color different from the one I have selected 
in Preferences? 

A. All CGM images have background color information built directly into the file. If you open an image like 
this, HiJaak PRO will view it with the file specified background color, rather than the one you selected 
in the Preferences dialog box.

Q. Why do I get a blank image or an image with missing parts when I convert a WMF file to CGM?
A. Your WMF image probably contains primarily raster information. HiJaak PRO does not support raster 

information in CGM files, so only the vector portions are being saved in the CGM file. 



GEM

Q. Why does my conversion to GEM create an image with incorrect colors?
A. The GEM format uses a fixed color palette, so conversions from formats without the same palette 

limitation may produce undesired color changes in GEM. To remedy this problem, use HiJaak PRO's 
Change A Color option under the Colors menu to remap colors in the source image to the desired 
colors in the fixed GEM palette.



DXF

Q. Why don’t my DXF to IGS, WRL, 3DS, DWG or DXF conversions work properly?
A. HiJaak PRO is probably opening the files as 2D: HiJaak PRO supports 2 different ways to open DXF 

files: open as 2D and open as 3D. The open as 2D option uses HiJaak PRO’s traditional mode to open
DXF files. It can read up to DXF version 12. The open as 3D mode uses HiJaak PRO’s advanced 
mode to open DXF files. It can read up to DXF version 13. By default, HiJaak PRO uses the advanced
mode to open files (open as 3D). If you want to convert a DXF file to IGS, WRL, 3DS, DWG or DXF 
you must open the original DXF file as 3D. 

          In the Open or Convert dialog box, select a DXF file then click the Options button. The DXF Source 
Options dialog box displays. In the Open File As area, click the 3D radio button and click OK. Set the 
remainder of the convert options and your conversion should complete successfully and accurately.

Q. Why won’t HiJaak PRO open my DXF files?
A. The Open as 2D option may be selected in the DXF Source Options dialog box and the DXF file may 

be version 13. HiJaak PRO can only open DXF version 13 files as 3D (2D files will open successfully 
in this mode). In the Open dialog box, select the DXF file you want to open and click the Options 
button. In the DXF Source Options dialog box, click the Open File As 3D radio button and click OK. 
In the Open dialog box, click Open. The DXF file should open successfully.

Q. Why does HiJaak PRO display my DXF files as a blank white window?
A. Your image is probably the same color as the background window. Open the image and render it 

wireframe (View\Rendering\Wireframe). Then pull down the Colors menu and click Reverse Black 
and White. If it appears blank, try Reveal Background Color Objects from the Colors menu.. Note 
that this option will have no effect when you render an image either flat or gouraud.



EMF

Q. Why can’t I process (change colors, grayscale, invert colors, etc.) an EMF file that HiJaak PRO 
creates from any raster file?

A. There are some limitations to HiJaak’s support of raster components in metafiles. If you need to save a
file in EMF format and perform processing options, process the original raster image first, then save it 
in EMF format.



ICO

Q. Why don’t any of my icon files created by HiJaak PRO import into any of 
my applications?

A. HiJaak PRO can create two types of icon files: 16 color and 256 color. Windows 3 applications support 
16 color icons only, and although Windows 95 supports 256 color icons, not all Windows 95 
applications do. By default HiJaak PRO creates Windows 95 256 color icons. If you find that your 
applications won’t import an icon file created by HiJaak PRO, reconvert the file and in the Processing 
Options dialog box, pull down the Flavors list and select Windows 3. HiJaak PRO will generate a 16 
color icon file that should import into any application that supports ICO.

Q. Why doesn’t HiJaak PRO create thumbnails of ICO files?
A. Although HiJaak PRO supports Icon *.ICO files, by default, it does not create thumbnails of them 

because Windows display these thumbnails by default. 



JPG

Q. Why does the quality of my image degrade when I convert to JPG?
A. JPEG uses a “lossy” compression scheme. This means that JPG trades smaller file size for quality. If it

is important for you to create a high quality JPEG image from your conversion, click the Options button
in the Save As or HiJaak Convert dialog boxes during the conversion. The Processing Options dialog 
box displays. Drag the Quality slider to the left, toward “High.” Click OK to exit the Processing Options 
dialog box.



 PCL

Q. Why does my PCL image have incorrect fonts? What does the Font File Not Found error 
message mean?

A1. HiJaak PRO stores font file information in a file called SOFTFNT.HDR. This error may appear if 
something is wrong with SOFTFNT.HDR. Delete the file from your HJPRO\BIN directory. HiJaak PRO 
will rebuild the file for your next conversion.

A2. If you are producing the PCL files from Windows 95, set the Print TrueType Fonts as Graphics 
option in the Printer Setup Options.
PCL 4 files, such as those supported by HiJaak PRO, generally contain all information that a LaserJet 
II compatible printer will require for accurate printing and will show up with correct fonts in HiJaak 
PRO. However, some applications keep important font information separate from the document 
information. Those applications will produce incomplete PCL files that will probably not function as 
expected in HiJaak PRO and may cause a Font File Not Found error message during conversion. For 
these PCL files to function properly, it is important to enter the Source PCL Options screen at the 
beginning of a PCL conversion and download the appropriate font files into HiJaak PRO. Downloading 
of fonts into HiJaak PRO will usually not be required for a successful PCL conversion as fonts are 
typically included in the PCL file itself.

If neither of these solutions work, you can use HiJaak Print Capture to print the file to a format other 
than PCL. For more information, click on the following:
Using HiJaak Print Capture



# TIF$ Troubleshooting TIFK TIF, troubleshooting



TXT

Q. Why doesn’t HiJaak PRO create thumbnails of TXT files?
A. Although HiJaak PRO supports ASCII TXT files, it does not thumbnail name. By default, it maintains 

the TXT icon association with Notepad. 

Q. Conversions of Text files to CGM result in a zero-length file or an empty image. What can I do to
get a successful conversion of TXT to CGM?

A. Text to CGM conversions produce blank images or zero-length files when the conversion is done with 
the Stroke Fonts option set to On. To correct the problem, de-select the Stroke Fonts option.

Q. I can’t read any of the TXT files I open. How can I make the text larger and more readable?
A. The text becomes difficult to read because HiJaak PRO may be scaling it. Pull down the View menu 

and point to Auto Scale; click Page in Width. The display should become much easier to read.



WMF

Q. Why do I get a blank image or an image with missing parts when I convert a WMF file to CGM?
A. Your WMF image probably contains primarily raster information. HiJaak PRO does not support raster 

information in CGM files, so only the vector portions are being saved in the CGM file. 



 General conversion problems

Q. Why does my image file become corrupted when I am doing a conversion from that source to 
an identically named file in the same format?

A. During conversions, HiJaak PRO reads the image information from the source file, processes it and 
then saves it to the destination file. If the source and destination files have the same path and name, 
HiJaak PRO will be forced to save information into a file from which it still needs to read information. 
This activity may corrupt the file. Selecting the Overwrite Notification check box in the Save As and 
HiJaak Convert dialog boxes will provide a warning when existing files are about to be overwritten. 
Changing the path and/or filename of the destination will prevent the corruption of the source file.

Q. When I try to convert a file, HiJaak PRO goes into an endless loop and I have to reboot. What 
can I do to prevent this?

A. HiJaak PRO will go into an endless loop if the buffer size is less than one scanline of data. To fix this 
problem, pull down the HiJaak PRO Setup menu and select Preferences. You will see the 
Preferences dialog box. In the Buffer Size area, increase the current value. For example, if your 
current buffer size is 16,000, enter 20,000 and try the conversion again. You can increase your buffer 
size up to 64,000.

Q. Why doesn't HiJaak PRO create files with the right number of colors when I 
convert from a vector to a raster format?

A. When you are converting from a vector to a raster format, HiJaak creates a file with the 
same number of colors as the display mode you are using in Windows. For example, if 
Windows 95 is running in 8-bit mode, HiJaak PRO will create 8-bit destination files (256 
colors), regardless of the number of colors in your source file. If you need to convert high 
color source files to high color destination files, you need to change your Windows display
mode through the Control Panel. Most graphics cards offer both a high resolution, lower 
number of colors, and a high-color, low resolution display mode. Select the display mode 
with higher number of colors and a lower resolution and convert your files.



Error Messages

The following are some of the most common error messages in HiJaak PRO. Click on the error that you 
need help correcting.
Warning 2 --   PCL  :   The Source could be in PCL 5
Warning 8 --   GIF  :   This image may contain text that cannot be displayed.
Error -- 101: Couldn't allocate virtual memory.
Error -- 298: Resource was not found. Please reinstall.
Error -- 1002: Source file type is unsupported.
Error -- 1003: Source file doesn't match type. Different flavor.
Error -- 1005: Font file not found or SOFTFNT.HDR file may be corrupt. 
Error -- 1025: Internal error.
Error -- 1036: Missing a DLL.
Error -- 1047: EPS->EMF File open failed.
Error -- 1049: EPS->EMF BAD HiJaak Print Capture Printer Driver.
Error -- 1050: EPS->EMF No information available.



 Warning 2: This warning appears if HiJaak PRO detects information in the file that may be PCL 5. Certain 
elements are the same in both PCL 4 and PCL 5 files; however, HJDT only supports PCL 4 files. If the 
conversion fails or is inaccurate, it may be because the file contains PCL 5 information.



    Warning 8: This warning indicates that text in the GIF file may not appear when the file is opened. This 
refers to ASCII text, as opposed to text that has been rasterized and is part of the raster image. The file 
will still open.



Error 101: This error occurs if there is no more space on your hard drive for temporary files. Free hard 
disk space by deleting or moving files from the hard drive.



Error 298: If HiJaak PRO is missing a resource file, it will not run. You must reinstall to add that file. 



Error 1002: This error occurs if the file extension is not recognized by HiJaak PRO. If HiJaak PRO 
doesn't recognize the extension, it will not open the file. If you know the file type, check the Supported 
Formats in the HiJaak PRO User Guide to see if it is supported. If the file type is supported, you can 
change its extension, thereby allowing HiJaak PRO to open it: rename the file using HiJaak Browser and 
give it an extension that HiJaak PRO will recognize. If the file still does not open, it is probably not in a 
supported format.



Error 1003: This error may occur for one of the following reasons:
The file type may be different from that which is indicated by the extension. HiJaak PRO assumes 
that the file extension of a file represents the actual file type. However, this may not always be the case. If
a file has an extension that does not represent the file type, HiJaak PRO will not read the file correctly and
you will receive this error. You need to find out how the file was created in an effort to discover the file 
type. When you discover the file type, check the Supported Formats in the HiJaak PRO User Guide to 
see if it is supported. If the file type is supported, you can use HiJaak Browser to change its extension, 
thereby allowing HiJaak PRO to open it.
The file may be corrupt. Check the file by opening it in another application. If the file does not open, 
it is probably corrupt. If it does open, the file type is probably different from what is indicated by the 
extension. You need to find out how the file was created in an effort to discover the file type. For example,
the file may have been saved with the wrong extension. When you discover the file type, check the 
Supported Formats in the HiJaak PRO User Guide to see if it is supported. If the file type is supported, 
you can use HiJaak Browser to change its extension, thereby allowing HiJaak PRO to open it.



Error 1005: HiJaak PRO stores font file information in a file called SOFTFNT.HDR. This error may appear
if something is wrong with SOFTFNT.HDR. Delete the file from your HJPRO\BIN directory. HiJaak PRO 
will rebuild the file for your next conversion.



Error 1025: This error may occur if the settings are corrupt. If you receive this error, you need to load the 
default HiJaak PRO settings. Select Load Defaults from the Setup menu.



Error 1036: If HiJaak PRO is missing a DLL, it will not run. You must reinstall to add that DLL.



Error – 1047: HiJaak PRO is unable to read the PostScript file you are trying to open: either the file is not 
graphical, is corrupt or contains information that HiJaak PRO cannot process. For example, HiJaak PRO 
cannot read the PS file’s in its ZENO directory because they are not graphics files, they are HiJaak 
system files (do not try to open them). There is no work around for this error.



Error – 1049 HiJaak PRO uses the HiJaak Print Capture printer driver files to open, convert and display 
EPS files. If HiJaak Print Capture has been moved or deleted, HiJaak PRO will not be able to work with 
EPS files. Run HiJaak Setup from the HiJaak PRO folder in the Start menu to reinstall the HiJaak Print 
Capture drivers and try again.



Error – 1050: HiJaak PRO is unable to read the PostScript file you are trying to open: either the file is not 
graphical, is corrupt or contains information that HiJaak PRO cannot process. For example, HiJaak PRO 
cannot read the PS file’s in its ZENO directory because they are not graphics files, they are HiJaak 
system files (do not try to open them). There is no work around for this error.



Basic look of an image

Problems with the Way Your Image Looks
If your opened, processed or converted image doesn't look the way you expect it to, there may be a way 
to fix it. Click on one of the following topics for more information.

 Parts of my image are missing
 My rotated image doesn't look right
 I can’t crop my image

Note: If your image looks bad after performing multiple processing operations on it, try saving and re-
opening the image between each operation.



Parts of my image are missing

Q. Why are some elements of my vector image missing?
A. If elements (lines, arcs, etc.) the same color as the background are not visible, use Reveal 

Background Color Objects to restore the image. This option sets initially invisible objects to a color 
that contrasts with the background.

Q. Why does changing my color raster image to black and white (Number of Colors=2) result in 
the loss of part(s) of the image?

A. If you try to force a raster image to black and white, it may appear to lose some part(s) of the image, or
even result in an all black or an all white image.    This may indicate that HiJaak PRO's selection for 
what colors to make black and what colors to make white is inappropriate for the image you are 
working with.    Use the Change a Color option from the Colors menu to manually change your colors 
to the appropriate black and white output.    HiJaak PRO remembers your color changes, and gives 
you the option to apply them in future similar conversions.



My rotated image doesn't look right

Q. Why does my image keep getting smaller the more I rotate it?
A. When you rotate an image, HiJaak PRO adds padding around the image to allow it to fit in a 

rectangular window. As you continue to rotate, more and more padding is added, which causes the 
image to shrink. If you don’t want this to happen, select Edit\Undo after each rotate, and then 
increase the rotation angle the desired amount in the Rotation Options dialog box.

Q. Why doesn’t the entire image rotate when I rotate a metafile image? Parts of it are rotated and 
parts of it remain the same.

A. HiJaak PRO cannot rotate the raster elements contained within a metafile image. If you need to rotate 
a metafile image containing raster elements, convert it to a raster format such as BMP and then rotate 
it.

Q. After I rotate my PCL file, why do my fonts change?
A. The PCL4 used by HiJaak PRO in emulation of the LaserJet II does not provide for the rotation of 

fonts. HiJaak PRO substitutes an already-rotated font whenever text in a PCL file is rotated. That may 
cause the look of the PCL file to change. To avoid the change in font, convert the PCL file to PCX and 
then back to PCL. The conversion through PCX will cause text to become bitmapped representations 
of the original font. Subsequent rotation of the PCL file will not change the appearance of the text.

Q. Why won’t my PCL files rotate?
A. This is a known bug in version 4.0. We are working on a fix and will have it to you as soon as possible. 

Call 1-800-683-6866 for information on when a fix will be available.

Q. Why does a colored background appear when I rotate an image after using the Optimize Palette
option on it?

A. When an image is rotated a number of degrees that is not an even multiple of 90, the resulting image 
will no longer fit into the rectangular window available for it. HiJaak PRO must pad the image with 
pixels of a certain color to fill out the rectangular window. Whenever possible, HiJaak PRO will fill out 
the image with the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, eliminate the 
background color from those available for the particular image. Another background color -- one that is
available in the new optimized palette -- is selected to fill out the image window. To ensure that no 
color substitution takes place, rotate the image before selecting optimize palette. Performing the 
rotation first will introduce the background color into the image and it will be preserved as part of the 
palette through the optimization process.



I can’t crop my image

Q. Why can’t I crop any of my PCL files?
A. This is a known bug in this version of HiJaak PRO. We are working on a fix and will have it to you as 

soon as possible. Call 1-800-683-6866 for information on when a fix will be available.

Q. Why is the Crop command disabled?
A. Cropping is not available with 3D images or 2D images opened in 3D mode. 



Macintosh Files

Moving Graphics Files from the PC to the Macintosh
Moving files to the Macintosh can be done in several ways. The following procedure is one way that only 
uses software provided with the Macintosh itself. If you plan to do a large amount of file transfer between 
platforms, an Apple dealer can recommend software that will automate this process. 

If you have successfully moved the file to the Macintosh, but cannot open it in your application, you may 
need to change the file's type code. For more information, click on the following:
Changing a File's Type Code

Move the file onto the Macintosh Hard Disk as Follows:
1. Create a file using HiJaak which is compatible with the application in which you plan to use it. If you are

not sure which format to use, PICT (.PCT) and TIFF (.TIF) are two of the most common formats used 
in Macintosh applications.    Please note that there are several different flavors of both PICT and TIFF, 
and some may not be compatible with applications that read those formats.    

2. Copy the file to a DOS formatted 3.5" floppy disk.
3. Take the floppy to the Macintosh. Before inserting the disk in the Macintosh, run the Apple File 

Exchange program.
Note: Apple File Exchange is a program that allows certain Macintosh floppy drives to read and 
write PC disks. If you do not have this program on your System disks, contact your Apple dealer 
to check the compatibility of your Macintosh drive.

4. Once Apple File Exchange is running, insert the floppy in the Macintosh. The program window will be 
split into two parts:    one for the floppy and one for the Macintosh. First, select the folder on the Mac 
disk in which you want to copy the file. Next, select the file from the PC disk to be copied, and click the 
Transfer button in the middle. Once you are finished copying files, click the Eject button to eject the 
disk, then select File/Quit to close Apple File Exchange. Your file should now be on the Macintosh hard 
drive.

You should be able to open this file in your application. If the file does not show up in the application's 
Open dialog box, you will need to edit the file's type code to make it compatible with your application. 
For instructions on editing a file's type code, click on the following:
Changing a File's Type Code



Changing a File's Type Code

This procedure described how to edit a file's type code to make it compatible with your Macintosh 
application. Use this procedure if you have transferred a file to the Macintosh, but are unable to open it in 
your application.

Change a File's Type Code on the Macintosh as Follows:
1. Copy the file from the floppy to a Mac hard disk. 
2. Open ResEdit. This is a utility distributed by Apple. It comes on certain versions of the Macintosh 

System disks.    If you do not have it, contact your Apple dealer.    here are other utilities that can also 
change a file's Type code.    f you'd prefer to use one, consult the program's documentation and the 
table of Type codes shown in step 3 below.

3. In ResEdit, select File/Open.    Select the name of the file you want to work on.    Click OK.    If ResEdit 
asks for confirmation about adding a resource fork to the file, click OK.    The resource fork is needed 
for the file to work in some Macintosh applications.

4. Select File/Get Info for filename. This will bring up a box which contains information about the file. 
There will be two text fields named Type and Creator.    These are what need to be edited.    Highlight 
the text in the Creator field and delete it, leaving the field blank.    For the Type code, delete the text in 
the field and replace it with the appropriate code for the type of file it actually is from the list below.    
Note that all codes must be in all uppercase and have no spaces.

If the file is a the correct Type code is...
TIFF (*.TIF TIFF
PICT (*.PCT) PICT
EPS (*.EPS, *.AI) EPSF
MacPaint (*.MAC) PNTG

        Once the codes are correct, select File/Save, then File/Exit. The file should now show up in your 
application's File..Open dialog box and be readable in your application. If you have a file whose Type 
code is not listed above, create a file of the same format in your application, and follow steps 1-3 
above. Instead of changing the Type and Creator codes, however, note the Type code and then select 
File/Exit without changing anything. That Type can then be used when working on file of that format 
from the PC.



Printing

For tips on getting better results printing in HiJaak PRO, click on one of the following:

 Black and white print-outs of color images
 General printing tips
 Printing errors



General printing tips

Q. How can I improve the print quality of vector images that contain rotated text?
A. Rotated text within vector images is sometimes placed incorrectly in HiJaak PRO printouts. To ensure 

that the text will print properly, select Print TrueType Fonts as Graphics in the setup screen for your 
printer.

Q. What scaling options should be used on my image to ensure the best quality printing?
A. When scaling an image for printing, select horizontal and vertical resolutions that match those of your 

print device. If the image was to be printed on a typical laser printer, for example, the resolutions 
should be set to 300. After setting the appropriate resolutions, the width and height fields should be 
filled in with the dimensions desired in the printed output. Selecting Maintain Aspect Ratio will ensure
that the proportions of the original image are preserved while the image is being scaled.



Printing Errors

Q: Why do I get a blank page when I print from HiJaak PRO?
A: This error might occur if your HiJaak PRO settings have been corrupted. When this occurs, close the 

image you are trying to print and reload the default set file by pulling down the    Setup menu and 
selecting Load Defaults. In the Load Settings dialog box, click on the Defaults button. If this does 
not correct this problem, contact Inset technical support.

Q: Why doesn’t HiJaak PRO save the paper orientation setting?
A: HiJaak PRO saves only HiJaak print settings. The paper orientation is a printer settings. If you want to 

change the paper orientation permanently, you need to change your printer setup.



Scaling and Resizing

For tips on scaling and resizing your images in HiJaak PRO, click on one of the following:

 Changing the size of an image
 Preventing distortion while scaling or resizing
 Getting the best print-outs when scaling



Changing the size of an image

Q. Why isn’t the Resize command available for my vector and metafile images?
A. Vector and metafile images consist of mathematical instructions for how to create objects. Since the 

objects themselves don’t have a set size, they will size and scale automatically as you change the size
of the image window. 

Q. How can I scale an image to be two or three times the size of the original?
A. HiJaak PRO allows for this type of scaling through the Multiples selection under Units in the Resize 

dialog box. Once Multiples is set as the unit of scaling, the image will be scaled a number of times 
equal to the values placed in the width and height fields. For example, entering 2 in the width field and 
2 in the height field will produce an image that is double the size of the original.

Q. How can I size an image to match the dimensions of my screen?
A. Selecting Fit in Display Width from the Resize dialog box will scale your image to be precisely as 

wide as your display screen. It will preserve the proportions of your original image. Selecting Fit in 
Display will scale your image to be precisely as wide and as tall as your display screen. If necessary, 
this scaling option will distort the width to height proportion of the original image.



Preventing distortion while scaling or resizing

Q. How can I prevent stretching or squashing of my image when I resize it?
A. Stretching or squashing of an image may occur when the height and width values entered by the user 

are not in the same proportion as the width and height of the original. The Maintain Aspect Ratio 
selection on HiJaak PRO's Resize dialog box ensures that the proportions of the original image are 
preserved during scaling.



Getting the best print-outs when scaling

Q. What scaling options should be used on my image to ensure the best quality printing?
A. When scaling an image for printing, select horizontal and vertical resolutions that match those of your 

print device. If the image was to be printed on a typical laser printer, for example, the resolutions 
should be set to 300. After setting the appropriate resolutions, the width and height fields should be 
filled in with the dimensions desired in the printed output. Selecting Maintain Aspect Ratio will ensure
that the proportions of the original image are preserved while the image is being scaled.



Text and Fonts

For advice on dealing with known problem areas related to text and fonts in HiJaak PRO, click on one of 
the following:

 I'm having problems with fonts in my PCL files
 Text in my ASCII TXT file looks wrong
 Text in my DXF file looks wrong



I'm having problems with fonts in my PCL files

Q. Why does my PCL image have incorrect fonts? What does the Font File Not Found error 
message mean?

A. A PCL 4 file, such as those supported by HiJaak PRO, generally contains all information that a 
LaserJet II compatible printer will require for accurate printing and will show up with correct fonts in 
HiJaak PRO. However, some applications keep important font information separate from the document
information. Those applications will produce incomplete PCL files that will probably not function as 
expected in HiJaak PRO and may cause a Font File Not Found error message during conversion. For 
these PCL files to function properly, it is important to open the Source PCL Options screen at the 
beginning of a PCL conversion and download the appropriate font files into HiJaak PRO. It is important
to note that downloading of fonts into HiJaak PRO will usually not be required for a successful PCL 
conversion as fonts are typically included in the PCL file itself.

Q. How can I avoid the change in font that occurs when I rotate my PCL file?
A. The PCL4 used by HiJaak PRO in emulation of the LaserJet II does not provide for the rotation of 

fonts. HiJaak PRO substitutes an already-rotated font whenever text in a PCL file is rotated. That may 
cause the look of the PCL file to change. To avoid the change in font, convert the PCL file to PCX and 
then back to PCL. The conversion through PCX will cause text to become bitmapped representations 
of the original font. Subsequent rotation of the PCL file will not change the appearance of the text.



Text in my ASCII TXT file looks wrong

Q. When I am viewing an ASCII TXT file, the font in my TXT file is incorrect and extends beyond 
the border of the window.    How do I correct this?

A. Your settings have probably been corrupted.    Pull down the Setup menu and select Load Defaults. 
Restart HiJaak PRO and open your TXT file again.

If this doesn't work, check in the Windows Control Panel Font utility to make sure you have TrueType 
fonts enabled. If they were not, enable them and try again.

If this doesn't work, then the IBMPCDOS font that HiJaak PRO expects to read has probably been 
deleted from your HJPRO or folder.    Double-click on the HJSetup icon to reinstall that font, and try 
again. If that doesn't work, you will have to re-install HiJaak.



Text in my DXF file looks wrong

Q. The fonts in my DXF file don't look right. What can I do to correct them?
A. If the fonts in your DXF file are out of place, the wrong size or the wrong font, HiJaak PRO may not be 

able to located the correct fonts on your system. Pull down the HiJaak PRO Setup menu and click 
Setup Fonts. In the Setup Fonts dialog box, select your path to AutoCAD or the drive on which you 
have installed Windows 95. HiJaak PRO will search the selected paths for TrueType fonts and register 
them with Windows 95, thereby making them available to HiJaak for displaying and converting files.
If this doesn’t work, open the DXF file in AutoCAD and use the "Explode" command. This command will
change the font into line segments, which should display properly.



 Capture

For advice on problems with HiJaak PRO's Capture, see below:

 I can't capture it...
 My Windows capture doesn't look right



I can't capture it...

Q. Why can’t I capture any of the special cursors I’m using with Windows?
A. When you select Show Cursor, HiJaak PRO will always capture the Windows default cursor types, 

regardless of the special cursors you may be using. This is a limitation of HiJaak Capture that we hope
to improve in a future release.

Q. Why am I unable to capture my application's pull-down menu with HiJaak PRO?    Every time I 
hit the hot-keys to capture an area, the menu goes away.

A. When capturing a pull-down menu with HiJaak PRO, make sure that you DO NOT select Prompt for 
File Options in the HiJaak Capture dialog box. This prompt closes the pull-down menu because 
Windows may have only one menu open at a time. Deselect Prompt for File Options and use the 
Hotkey method to capture the pull-down menu.

Q. Why can't HiJaak Capture capture DOS windows? Every time I hit the hotkeys, the keystokes 
appear in the DOS window and HiJaak does nothing.

A. When a DOS window is active, it will "grab" the hotkeys before HiJaak has a change to interpret them. 
If it doesn't matter if the DOS window is active, you can click anywhere outside the DOS window and 
press the hotkeys to capture. If you need the DOS window active in the screen capture, set the Timer 
option in the HiJaak Capture Options dialog box to 5 seconds. When you are ready to take the 
capture, click anywhere outside the DOS window. Press the hotkeys, then click on the DOS window to 
reactivate it. 5 seconds after pressing the hotkeys, HiJaak Capture will capture the activated DOS 
window.



My Windows capture doesn't look right

Q. Why does HiJaak Capture change the look of my Windows screen when I press the hotkeys, 
and then capture this modified view rather than the one I set up?

A. The hotkeys you are using are probably conflicting with a hotkey or shortcut key used in the application
window you are capturing. For example, suppose you had Ctrl+X set up as your HiJaak Capture 
hotkeys and you were taking a capture selecting text in a word processing application. When you 
pressed the hotkeys, the selected text would disappear before HiJaak captures the screen. This is 
because Windows has assigned Ctrl+X as the shortcut keys for cut to the Clipboard. Because your 
application has focus when you press the hotkeys, it will grab them before HiJaak Capture, and your 
application’s appearance will change before HiJaak Capture grabs the screen. To solve this problem, 
make a note of the standard hotkeys and shortcut keys that your application uses and make sure you 
change the HiJaak Capture hotkeys to something other than those.

Q. Why do I lose the outline around my captured window?
A.    HiJaak PRO gives you the choice of whether or not to add an outline border to your captured window.

If you would like to include this border, select Border in the HiJaak Capture dialog box.

Q. Why does the border around my image become corrupted when there are objects on the edge 
of the capture?

A.    The image border is not corrupt. When HiJaak PRO places a border around a captured image, it 
determines the color of the border by determining the color of the object it is bordering. If the object is 
white, the border is black. If the object is black, the border is white.

Q. What should I do if my captured screen, area or window/object doesn't look the way it originally
did? 

A. If your captured image is completely black, has the wrong colors or just looks "funny," it could be 
related to your Windows video driver. If you experience these problems with HiJaak PRO's Windows 
capture, try using the regular VGA or the generic SuperVGA color video driver in the Control Panel's 
Display/Settings.

Q. Why is does the background color of my capture appear with a dithered pattern, rather than the
actual color on the screen? 

A. HiJaak PRO displays captures with this dithered background, the actual file has the correct color. 



Find

Q. Why doesn't HiJaak Find locate files I know exist?
A. HiJaak Find may not locate files for several reasons: HiJaak Find is limited to finding 

graphics files that are located in the HiJaak Catalog. Make sure that the files for which you
are searching are in a HiJaak-supported graphics format, and make sure that the files 
have been included in the HiJaak Catalog. To see which files are in the HiJaak Catalog, run 
the HiJaak Catalog Setup program from the Control Panel. Click on the Catalogs tab to 
display a list of all folders and files contained within the open HiJaak catalog.

Q. Why can't I perform any file operations out of the search results window? I 
can't open, import, copy, etc.

A. If you have run the search and then moved files using a means other than HiJaak Catalog 
Find, HiJaak PRO will not be able to locate them to perform the file operations. To fix this 
problem, you need to refresh the search results window. Don't change any of the search 
criteria and click on Find Now. The search results window will update to reflect the new 
file information.

Q. How come when I select "Files in unavailable drives or folders," HiJaak finds my files that are 
on the removable media with no problem, but I can't do anything with them?

A. HiJaak PRO needs to have physical access to the files in order to perform any file operations on them. 
You can use this feature to find the location of the files you need. Then you can connect to that drive or
folder and open the file using Windows Explorer.

Q. Why does HiJaak Find crash when I select Open Containing Folder?
A. HiJaak PRO only supports this option when one file is selected. If you select multiple files and select 

File\Open Containing Folder, HiJaak Find will crash.

Q. Why doesn’t HiJaak Find locate 3D files containing fonts?
A. This version of HiJaak PRO only supports locating fonts in 2D files. Fonts in WRL, 3D DXF, IGS, CGM 

or DWG files cannot be found.





Catalogs and Updates

Click the topic about which you need answers or advice:

Thumbnails and File Properties
HiJaak Catalog Controls: HiJaak Update, SHCENTER.EXE and the task tray globe icon
Catalog Errors



HiJaak Thumbnails and File Properties

Q. How can I improve the quality of the thumbnails HiJaak PRO generates?
A. To get the best quality thumbnails, set up Windows 95 to use the highest color display mode you have 

available before you run update. If you want to improve the quality of existing thumbnails, deselect 
Smart Update in the Setup Update page of HiJaak Catalog Setup, switch to the highest color display 
mode and run update again. You can also improve the quality of the thumbnails by increasing their 
size. You can do this in the Setup page of HiJaak Catalog Setup.

Q. Why do I have thumbnails for BMP that I haven’t updated and why do they paint slowly?
A. Windows 95 can also create and display thumbnails of BMP files. Your Windows 95 is probably set up 

to do this. 
If you just want HiJaak PRO to create and display the thumbnails rather than Windows 95, you can run
HiJaak Update on your BMP files. 
If you don’t want Windows 95 to create or display thumbnails of BMP files at all, regardless of whether
you want HiJaak PRO to create and display thumbnails, you need to change your Windows 95 registry
file. To edit the registry file to prevent Windows 95 from creating or displaying thumbnails of BMPfiles, 
click here: .
To switch back to Windows 95 icons, click here: 

.
Note that before you see the effect of this change, you may have to clear the Windows Explorer cache. 
Click here for instructions: Clearing the Windows Explorer Cache.

Q. Why have my HiJaak PRO thumbnails disappeared from Explorer and where is my HiJaak 
Update icon that used to be in the tasktray?

A. Somehow HiJaak Catalog has become disabled. Run the HiJaak Catalog Setup. Select the Setup 
page and make sure that Enable HiJaak Shell Extensions is selected. If the HiJaak Shell Extensions
are not enabled, you will not be able to use thumbnails, shortcut menu items, catalogs or HiJaak 
Catalog Find.

B. If your only problem is that you can’t see thumbnails, try switching Explorer into Large Icon or    HiJaak 
Extra Large Icon mode. HiJaak thumbnails do not display in Small Icons or Details mode. If you still 
don’t see any thumbnails, run HiJaak Catalog Setup and make sure you have the correct catalog open
and it contains the thumbnails you expect to see. 

Q. Why aren't thumbnails updating properly? When I delete thumbnails from the catalog, they still 
appear in Windows Explorer, and when I modify a file and try to update the thumbnail, it 
doesn't change.

A. Windows Explorer stores some thumbnail information in memory, so it does not always display the 
changes right away. Try manually updating the thumbnail by selecting HiJaak Update from the shortcut
menu. If this doesn't work, restart Windows. 
If restarting Windows doesn’t work, you may need to clear the icon cache. For more information, click 
here: Clearing the Windows Explorer Cache

Q. Why don’t the Properties sheets in my 3D files include any font information?
A. This version of HiJaak PRO does not support cataloging font information in 3D files. 



HiJaak Catalog Controls: HiJaak Update, SHCENTER.EXE and the task tray globe 
icon

Q. Why does HiJaak PRO re-update files that haven't changed?
A. HiJaak PRO provides a Smart Update feature that checks the name, date and file size on files in the 

catalog before it updates them. It is selected by default. If HiJaak PRO is updating all files regardless 
of time and date, make sure the Smart Update control in HiJaak Catalog Setup's Setup Update page is
selected. Note that if you select HiJaak Update from a file's shortcut menu, Smart Update does not 
apply; HiJaak PRO always updates thumbnails when HiJaak Update is selected. 

Q. I don’t want to use HiJaak PRO’s shell extensions, catalogs or thumbnails. I only want to use 
the main HiJaak PRO application. How can I prevent the shell extensions from appearing?

. Run the HiJaak Catalog Setup from Control Panel. Select the Setup page and deselect Enable 
HiJaak Catalog. To disable shortcut menu items, you must also deselect each check box in the 
HiJaak shortcut menu items group box. You have to restart Windows 95 for this change to take 
effect.

Q. Shell extensions have been causing problems on my system that are preventing me from even 
rebooting Windows 95. The only way I can start Windows 95 is in Safe Mode? How can I fix this
problem?

A. The shell extensions may cause this problem on a very small percentage of systems. With Windows 
95 booted in Safe Mode, remove the program SHCENTER.EXE from the Windows Startup group and 
reboot Windows 95 normally. You will not have access to shell extensions anymore, but your previous 
problem with Windows 95 should be fixed. Do not rerun SHCENTER.EXE. 



Catalog Errors

Q. I just got an Error 1004: Catalog Corrupt error. What can I do?
A. The catalog can become corrupt for several reasons: maybe a power surge during updating, or 

rebooting without using Windows 95 Shut Down procedure. However, you may be able to recover your 
catalog file by forcing HiJaak Catalog Setup to rebuild some of the catalog files.

1. Run HiJaak Catalog Setup and click the Catalogs tab.
2. In the Catalogs tab, open another catalog you have created (one that is not corrupt), or create 

a new catalog. This catalog does not have to contain any files.
3. Close HiJaak Catalog Setup.
4. Run Explorer and switch to the folder where the corrupt catalog is located. If it is the default 

catalog, it will be located in C:\Program Files\HJPRO\Catalogs.
5. In this folder delete all CATALOGNAME.I* files. 
1. Run HiJaak Catalog Setup again and try to open the originally corrupt catalog. If it opens 

successfully (with no errors), your catalog has been successfully recovered. If you get an 
error message, then the catalog has been damaged to the point that it is unrecoverable.

Q. I have created several catalogs, but now HiJaak PRO reports that I don’t have any. How do I get
my catalogs back?

A. This may happen if you installed HiJaak PRO in addition to HiJaak Graphics Suite 95 and afterwards 
uninstalled HiJaak Graphics Suite 95. To fix this problem, run HiJaak Catalog Setup and click the 
Catalogs List button in the Catalogs tab. In the Catalogs List dialog box, click the Find Catalogs 
button. The Browse for Folder dialog box displays. Select the C:\Program Files\HJPRO\Catalog 
Folder and click OK. HiJaak PRO will now be able to use all catalogs created with HiJaak PRO again.



Clearing the Windows Explorer Cache
To save time, Windows Explorer keeps some information in memory. One of the items that it keeps in this 
“cache” is icon appearance. When you change the appearance of your icons, the icons may not show the
change right away because Windows is “remembering” the previous appearance of the icons and not 
repainting them. You can force Windows Explorer to clear this icon cache by forcing it to redraw icons. An 
easy way to do this is to change your icon size:
1. Click the secondary mouse button on the Windows Desktop and click Properties.

The Display Properties sheet displays.
2. Click the Appearance tab.
3. Pull down the Item drop down list and click Icons.
4. In the Size field increase or decrease the size and click Apply.

Windows redraws all icons at the new size.
5. If you want to change the size back, you can do so.
6. Click OK.



Viewing

Viewing images in 2D space
Viewing images in 3D space



Viewing Images in 2D Space

Q. Why does HiJaak PRO lock up when opening some of my images?
A.    This condition results from a low amount of available memory. A low memory condition 

is probably the result of Windows Explorer's memory caching. An easy way to clear out 
Explorer's cache is to change the size of the icons displayed in Windows: Open the 
Windows Control Panel and select Display. Click on the Appearance tab. Pull down the 
Item drop-down list and click on Icon. The Size field becomes enabled. Click in the Size 
field and type a different size at which to display your icons. Even a difference of 1 or 2 
pixels will work. Click on Apply. You can change the icons back to their original size at 
any time. Click on OK.

Q. Why does HiJaak PRO dither my images?
A.    When you use a 256-color display mode, HiJaak PRO uses a fixed palette to display 

images. This fixed palette dithers images. The dithering affects only the image display, 
not the image's output quality (printing or converting). If you don't want HiJaak PRO to 
dither your images, use the Control Panel's Display icon to switch Windows 95 into a 
higher color mode.



Viewing Images in 3D Space

Q. Why doesn’t fixed views display the view of the file I expect? The Back view 
displays a right profile, etc.

A. HiJaak PRO reads the default view designated in the file when it displays a 3D image. 
Then it determines the X, Y and Z coordinates of the image. The front and back view are 
displayed along the X axis, the left and right along the Y and the top and botton along the
Z. You may have to adjust your image based on these settings to get the view you want.

Q. Why won’t HiJaak PRO display many of my 3D files? All I see is a blank window!
A1.    If you are displaying the image in wireframe mode and the wireframe is the same color

as the background window, all you will see is a blank window. To see if this is the problem,
pull down the Setup menu and click Preferences. In the Preferences dialog box, select a
different color background and click OK. Open the image again.

A2. You can also try using HiJaak PRO’s Reveal Background Color Objects feature to fix the 
problem. Make sure your image is displayed wireframe then pull down the Colors menu 
and click Reveal Background Color Objects.

A3. If the 3D image was created by converting a 2D image to a 3D format, you may be 
looking at the side of the image, which consists of only a line. Try selecting a different 
fixed view: pull down the View menu, point to 3D Viewpoint and click on of the fixed 
views.

Q. Why can’t I zoom in on any of my 3D files?
A. The zooming commands are intended for use with 2D files. To zoom in on a 3D file, use the 3D 

Viewpoint Palette or the keyboard. In the 3D Viewpoint Virtual Reality Palette, use this button: . In 
the 3D Viewpoint CAD Engineering dialog box, drag the distance slider to the left (near). Or use the up
arrow on your keyboard.



HiJaak PRO and Windows 95 Applications

Q. Now that I have installed HiJaak PRO, Microsoft Network locks up every time I use it. What can I
do? 

A. This is a known interaction bug with Microsoft Network and HiJaak PRO that occurs on some systems.
When installed, HiJaak PRO adds a line to the Windows Registration database that conflicts with 
Microsoft Network. This line refers to the HiJaak Find utility. We do not know why the registration entry 
causes this conflict, but we do know that removing the line fixes the problem with Microsoft Network. 
Note that if you remove the line, you will no longer be able to use HiJaak Find. 
To remove the line from the registration database, click here . 
If you need to use HiJaak Find again, you will need to add the line back into the registration database, 
click here    

.

Q.      How can I associate a HiJaak-supported format with another application?
A.     In Explorer, highlight a file in the format that you want to reassociate. Press Shift+F10. You will see 

the file's shortcut menu with the option Open With. Select Open With and select the application with 
which you want to associate the format (file extension). Click on OK. 



System Problems

Q. Now that I have installed HiJaak PRO, my backup software doesn’t work. How can I do a 
system backup now?

A. When you start Windows, HiJaak PRO automatically loads its catalog, but some backup software does
not work properly when files are in use. To back up your system, you need to unload the catalog. Run 
HiJaak Catalog Setup and select the Catalogs tab. In the Catalogs page, click the Catalogs List 
button; the Catalogs List dialog box displays. In this dialog, click the Don’t Load Any Catalogs on 
Startup radio button and click OK. Close HiJaak Catalog Setup and restart your computer. Your 
backup software should work properly now.

Q. What can I do when my system hangs when I try to open or zoom a vector image? 
A. This problem is related to your video card and display. Open the Control Panel and double click the 

System icon. In the Performance tab, click the Graphics button and set the graphics acceleration 
options to a lower setting and try again. Keep decreasing this value until you no longer have the 
problem.

Q. Now that I have installed HiJaak PRO, Microsoft Network locks up every time I use it. What can I
do? 

A. This is a known interaction bug with Microsoft Network and HiJaak PRO that occurs on some systems.
When installed, HiJaak PRO adds a line to the Windows Registration database that conflicts with 
Microsoft Network. This line refers to the HiJaak Find utility. We do not know why the registration entry 
causes this conflict, but we do know that removing the line fixes the problem with Microsoft Network. 
Note that if you remove the line, you will no longer be able to use HiJaak Find. 
To remove the line from the registration database, click here . 
If you need to use HiJaak Find again, you will need to add the line back into the registration database, 
click here    

.

Q. Now that I’ve installed HiJaak PRO, I can’t even reboot Windows 95 without going into safe 
mode. What should I do?

A. The shell extensions may cause this problem on a very small percentage of systems. This 
is a known bug in HiJaak PRO and we are working on a fix that will be made available to 
you as soon as possible. Until then, with Windows 95 booted in Safe Mode, run REGEDIT. 
Then search for the key HKEY_CURRENT_USER\Software\Microsoft\Windows\
CurrentVersion\Run.
Click the secondary mouse button over the value SHCenter.EXE and/or RUNNER.EXE and 
select Delete. Reboot Windows.

Q.      Now that I have installed HiJaak PRO, I sometimes cannot switch between Norton desktops. 
What should I do?

A. Close down HiJaak PRO. Press Ctrl+Alt+Del to view a task list in Windows 95. Look for the program 
LOCO.EXE. Select it and click End Task. If there is more than one, end them all. Your system should 
return to normal.



Scanning (HiJaak Scan)

Q. Why doesn’t my scanner work with HiJaak Scan? 
A. If you installed your scanner after you installed HiJaak PRO, then your scanner may have overwritten 

important TWAIN files with older versions. To replace the old files with the newer versions shipped with
HiJaak PRO, run HiJaak Setup from the HiJaak PRO folder in the Start menu. Reboot your computer 
and try again.

Q. Why doesn’t my Microtek scanner work with HiJaak Scan? 
A. If you are having problems with Microtek’s scanners, see 

HTTP://www.mteklab.com/tech/PCFiles/default.html for special versions of the TWAIN files that might 
fix the problem.



Installing and Setting Up HiJaak PRO

Q. Why is HiJaak PRO displaying an error message when I try to uninstall it using the Control 
Panel’s Add/Remove programs applette?

A. If you have run uninstall and canceled out of it several times, or have deleted critical files from the 
HJPRO\BIN directory, some files that are necessary to help remove the entire program may be 
missing. Use Windows Explorer to delete the HJPRO directory and all of its contents to remove the 
HiJaak PRO program files. If you need to remove every trace of HiJaak PRO, you can either copy the 
contents of the CD\HJPRO\BIN directory to the HJPRO\BIN directory on your hard drive, or you can 
reinstall HiJaak PRO. This will restore those critical files that have been deleted. After restoring the 
HiJaak PRO files that are were missing, you can run the uninstall program again.




